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Abstract 
This Whitepaper describes the process of installing Openview Internet Services (OVIS) in a Microsoft 
Cluster. Included in the document are the necessary configurations to support failover.  This document 
covers a configuration where OVIS and SQL Server are installed on the same nodes of a cluster. The 
MS SQL database that is described in this paper is merely used as an example other database 
configurations would also work but are not detailed in the document. The user should rely on the 
database vendor cluster installation instructions as the primary source for information.  
 

Important 
• Support of OVIS in a cluster environment is limited to the scenario described in this document.  

Other cluster configurations types may work, but will not be supported.   
• The instructions in this document must be completed in the order given.  Performing the steps out of 

order may result in a partial install or uninstall of the product and require manual clean up. 
• Other Openview products are not supported on the OVIS cluster nodes, with the exception of the 

OVO agent. If you have Openview Operations for Windows, you must install OVIS in a separate 
node. 

• This document is based on installing OVIS 6.10. 
 

 



Prerequisites 

Cluster Software Prerequisites 
• Windows 2003 Server with Clustering, Service Pack 1  

• IIS version 6 

 

Cluster Environment Prerequisites 
• This guide is based upon a physical cluster with a shared disk. VMWare or Load Balanced 

clusters are not supported.  

• Configured and fully resolvable DNS for the OVIS nodes including the Cluster virtual server 
name. 

• An account with administrator rights on all the cluster systems is required for a Cluster Server 
installation, thus it is recommended to use this account to install OVIS as well. 

• The Microsoft Cluster must be installed properly with all of its functionality.  

• At least one group in the cluster should have a <File Share> resource defined. OVIS will 
install its data components on this <File Share> resource. 

• If the virtual server does not exist in the same group as the <File Share> resource group, a 
new virtual server must be created using a free registered IP address and associating a 
network name with it. 

• The <File Share> resource where OVIS is to be installed must have the IP Address, Network 
Name, and Physical Disk set among the <File Share> dependencies. Ensure that the cluster 
administrator has access to the <File Share> resource and that he has full access to it. 

• Each system of the cluster should be up and running properly. 

• If a system in the cluster has an existing version of OVIS software installed, you need to 
uninstall it prior to the setup (including OVIS Remote Probes). The upgrade option is not 
supported with OVIS installations into a Microsoft Cluster. 

• OVIS is to be installed on the same location (drive and path name) on all cluster nodes. 
Ensure that these locations are free. 

 

 



Configuring Prerequisites 

Cluster Groups 
This list of groups is optional.  You may choose to use different names and/or group your 
applications differently.  The names of the groups listed in this section will carry through out the 
document.  The Groups described below will be populated with the resources as you go through each 
section of this document. 
 
Create these groups by renaming the two of the existing groups to: 
OVIS Group (example: ovrnttc2d) 

• Shared Drive (example: Disk G) 
 
SQL Group (example: ovrnttc2c) 

• Shared Drive (example: Disk F) 

 

 
 

Set up IIS 
This step will handle the failover service of IIS. As part of this step we will move the wwwroot to the 
shared drive.  

• Verify that IIS is already installed on your nodes 

• Bring up the IIS Manager (Right click on my computer and select “Manage”).   

o Expand Services and Applications.   

o Expand Internet Information Services.   

o Expand Web Sites. 

o Right click on the Default Web Site and select Properties from the menu. 

o Go to the “Home Directory” tab. The Local Path field points to default web directory.  

o Copy the default web directory as noted in the Local Path to the shared drive of the 
group that contains the IIS application.  For example copy c:\inetpub\wwwroot to 
g:\wwwroot.  

 



o Go back to the “Home Directory” Tab and change the Local Path to point to the new 
wwwroot directory (i.e. g:\wwwroot). 

o Make sure that the Read permissions check box is checked on the Home Directory 
tab 

o Make sure that the IP Address on the Web Site tab has the entry (All Unassigned) 

• Add IIS to the Cluster Administrator 

o Bring up the Configuration Application Dialog:  File | Configure Application 

o Select Create New Virtual Server 

o Select Use Existing Group, pick the group that the IIS Application is in (example: 
OVIS Group) 

o Enter a Unique Name and IP Address (Example: ovrnttc2d, ping name to get IP 
Addr) 

o Accept defaults in the next windows 

o For resource type select:  Generic Script 

o For the Name Enter: IIS 

o For the Script Enter: c:\windows\system32\inetsrv\clusweb.vbs (Note. This location 
may vary based upon where windows is installed to) 

o Click Finish 

After the group is added you should see the following entries in the OVIS Group 

• OVIS Group IP Address 

• OVIS Group Name 

• IIS 

• Shared Drive (example: Drive G) 

 

 
 
 
 
 
 

 



Set up DTC (Distributed Transaction Coordinator) 
This step is for adding the distributed transaction coordinator. This is required for SQL Server 2000 
when installed in a cluster.   

• Open the Cluster Manger 

o Right click on the OVIS Group and select new Resource 

o Enter DTC for the name 

o Select Distributed Transaction Coordinator for the Type 

o Select install on both nodes 

o Select all for dependencies 

 

The dependencies for your configured DTC group should appear similar to this configuration. 

 

 



Install SQL Server 2000 
If you are planning on using Microsoft SQL Server in your cluster configuration please refer to the 
documentation for Administering SQL Server in the MSDN for additional information on installing SQL 
Server for a cluster. 
 
Currently Microsoft Cluster setup does not support a MSDE database. In the example we are 
configuring a Microsoft SQL Server database for OVIS. OVIS installer will detect the configured DSN 
and skip the installation of the standard OVIS database MSDE. 
 
1. Bring up the Cluster Administrator 
2. In the Cluster Administrator, make sure the system you are installing SQL Server on has ownership 

of the shared drive that will be used for the data files.  You can use the “move group” option to 
move to the system that you are installing on. 

3. Insert the SQL Server 2000 CD into the CD-ROM drive. Or copy the bits onto the node. 
4. Select Install SQL 2000 Components. 
5. Select Database Server – Standard Edition 
6. Select Virtual Server and enter a unique IP address and name.  (example: ovrnttc2c, one method 

for finding the ipaddress of the virtual server is ping the virtual hostname)  
7. Select Group that will contain SQL (example SQL Group) 
8. Select both nodes to install SQL server on. 
9. Select a non-quorum shared drive for the data files. 
10. Use Mixed Mode for authentication. 
11. Upgrade to SQL Server 2000 Service Pack 3a. 
12. Restart the system. 
13. Make sure the Virtual Server name can be resolved from other systems (DNS). 
 

*Note it is recommend to use the ‘default’ instance name when installing SQL Server. When tests 
were run with a non-default instance name the install failed during the virtual server install with an 
event ID 17052.  

**Important if installing SQL 2000 please ensure that you upgrade the instance to SQL Server 2000 
SP4 to avoid security issues associated with prior versions of the database. 

 

Your SQL Group after the installation should look similar to the one below.  

 

 



Create the Database 
Now that the SQL Server is installed you will need to create a Reporter database to be used OVIS. 
These instructions are particular to the configuration of a SQL Server database configuration for OVIS. 
Similar instructions can be found for Oracle in the Reporter_Database_Config.pdf.  
 

1. From the Start menu of the system you installed SQL Server on, select Programs > 
Microsoft SQL 2000 >Enterprise Manager. 

2. In the Microsoft Console Root window, select your SQL Server Group. 

3. If your SQL Server system is not listed under the SQL Server Group, right-click SQL Server 
Group, select New SQL 

4. Server Registration from the drop-down menu and follow the wizard online steps to 
register. 

5. Right-click Databases – New Database 

6. In the General tab for the Name box, enter a name for the database (example uses 
Reporter as the name). 

7. Select the Data Files tab and in the Database files segment, in the Initial size (MB) column, 
enter 100. 

8. Click OK to close the window. 

9. After the database is created, expand Security. 

10. Right-click Logins – new login. 

11. Select General Tab and in the Name box enter the user name openview. 

12. Under Authentication select the SQL Server authentication radio button and enter your 
password. 

13. Under the Defaults, select Reporter from the Database list box. 

14. Select the Database Access tab and under Database access check the Permit box that 
corresponds to Reporter. 

15. Under Database roles for Reporter, check public and db_owner and select OK to exit. 

16. Confirm the new password from Step 11. 

17. To verify User has Database Access, in the left pane expand the security folder, or click the 
plus sign next to each item: Security>Logins and you should see openview in the right 
pane. 

 

Establish an ODBC Connection to the Database 
Configure system DSN to Reporter database so that OVIS installer will detect the DSN entry and skip 
the installation of MSDE database. 
 
This step needs to be performed on each system that you will install OVIS on. 

1. From the Start menu, select Settings>Control Panel. 

2. Double-click Administrative Tools. 

3. Double-click Data Sources (ODBC). 

4. Select the System DSN tab. 

 



5. Select the Add... button to create a new Reporter data source. 

6. In the Create New Data Source dialog box select the SQL Server driver and the Finish 
button. 

7. In the Create a New Data Source to SQL Server dialog enter Reporter for the Name and 
make sure that the server name appears in the Server text box (ex: ovrnttc2c). Click Next. 

8. Select - With SQL Server authentication using a login ID and password 
entered by user. 

9. Check the box for Connect to SQL Server to obtain default settings. 

10. Enter the login ID and password that you used in the previous section to create the database. 
Select Next. 

11. Check Change the default database to, select Reporter, and click Next. 

12. Check Perform translation for character data and select Finish. 

13. In the ODBC Microsoft SQL Server Setup dialog select the Test Data Source… button. 

14. Exit the SQL Server ODBC Data Source Test by clicking OK. 

 

 



Install OV Internet Services on First Node 
(Repeat on each node you will be installing OVIS.) 
 
After your database installation is complete you can start the OVIS installation. Doing the steps in a 
different order might result in a incorrect cluster configuration. 

*Note if you have already configured IIS as a service to fail over when the OVIS installer stops it, it 
will fail over to the other node taking control of the shared drive with it.  You will see a retry or cancel 
popup, simply move control back to the node you are installing on and click retry in the popup.  
Another option is to shut down the other nodes during the install, that way control can not be 
transferred to another node. 

*Note after the installer performs a reboot, control will have transferred to the other node, and you 
will have to transfer it back. Another option is to shut down the other nodes during the install, that 
way control can not be transferred to another node. 

1. Insert the OV Internet Services Installation CD into the CD-ROM drive or copy the bits the 
node that has active ownership of the shared drive where the SQL Server data files were 
installed.   

2. Select Install OV Internet Services. 

3. In the Destination Folders dialog, be sure to select a local drive for the program files, and 
the shared drive you installed the data files for SQL Server for the data files.  For example, if 
G: was your shared drive you might select: 

Install hp OpenView Internet Services to:  
C:\Program Files\HP OpenView\ 
Install hp OpenView Internet Services Data to:  
G:\Program Files\HP OpenView\Data 

Important: Make sure you select the same Data directory you selected here when you 
install OVIS on other nodes in the cluster. 

4. Start OVIS Configuration Manager.  Select File>Configure>Web Server Properties.  
Enter the virtual server name created for the group that IIS is in (in this case the OVIS Group) 
for the fully qualified Hostname (ex: ovrnttc2.ovrtest.adapps.hp.com) and click 
OK.  

5. In the OVIS Configuration Manager select File>Configure>Probe Scheduling Options.  
Check the Do Not Restart Probes After Save box and click OK.  This is so that IIS is not 
restarted and control is transferred to the other node.  

6. Verify OVIS is working by creating a probe in the Configuration Manager and checking the 
Status.  Use “Local System” for the probe location if you want to deploy the probe locally. 
Make sure the correct fully qualified name (i.e. ovrnttc2.domaine.name) for the virtual server 
is configured in the Web Server Properties. At this point click Save in the OVIS 
Configuration Manager.  
 
This should update the config.dat file reference to the management server to point to the 
virtual server. The config.dat file is in the <data_dir>\datafiles\probe\policies directory.  It 
may take 1-2 minutes for the config.dat to be updated.  
 

**Note some of the OVIS dependant services might not have started on reboot. If you are not 
receiving data, check to see if the “hp openview internet services” service is started. You can check 
the services for OVIS at the command line with ovc –status. You can start the services with ovc –start. 

 



This behavior is related to OVIS not being completely configured in the cluster, once the OVIS cluster 
setup process is complete the service should started as designed. 

 

Install OV Internet Services on Additional Node(s) 
If you have already configured IIS as a service to fail over when the OVIS installer stops it, it will fail 
over to the other node taking control of the shared drive with it.  You will see a retry or cancel popup, 
simply move control back to the node you are installing on and click retry in the popup.  Another 
option is to shut down the other nodes during the install, that way control cannot be transferred to 
another node. 

After the installer performs a reboot, control will have transferred to the other node; you will have to 
transfer it back. Another option is to shut down the other nodes during the install, that way control 
cannot be transferred to another node. 

1. Stop HP Internet Services and Reporter services on the active node. 

2. Move the cluster group that contains the OVIS shared drive to the next node. 

3. Delete ComponentMatrix.cfg and DependencyMatrix.cfg from the conf 
subdirectory of the shared drive. 

4. Establish an ODBC Connection to the database -- See section above on this. 

Follow instructions from the previous section to install OVIS. 

 

Take note to ensure that you update the Fully Qualified Domain Name to the virtual server name. If 
you accidentally put an incorrect or unresolvable domain name into the Fully Qualified Domain Name 
field. You can also use the <ovis install dir>\bin\ovisactivate.exe module to set the Fully Qualified 
Domain Name on each node to set the OVIS system to the correct domain name.  

 

 



Set Up TIPs 
In this phase of the clustering setup, both configuration and failover setup activities are performed to 
synchronize TIPs with the cluster environment.  In brief, this includes: 

• Cleaning up of the default configuration produced as part of the install process, 
• Associating the TIPs Server with the Virtual Server, 
• Preparing the TIPs Runner to be aware of the physical nodes within the cluster, and 
• Finally configuring all TIPs Runners to communicate with the TIPs Server via the cluster’s Virtual 

Server. 
 

Setup TIPs Runner Failover Script 
Since all configuration is stored upon the OVIS Cluster’s shared drive, each time a failover occurs the 
TIPs Runner configuration must be updated to reflect which physical node it is running on (e.g., a 
failover to NodeB requires the Runner’s configuration to be updated to reflect that it is now running on 
NodeB).  This is accomplished through a failover script that is executed prior to the Runner coming 
online on a physical node.  The steps below outline the failover scripts installation and required 
adjustments for the script on each node in the cluster.    

1. Create the directory <OVIS App Install Dir>\lbin\tips on each node in the cluster. Your app 
location should be similar to c:\program file\hp openview 

2. Copy the script TIPsRunnerFailover.vbs to the above directory on each node. This script can 
be found in the appendix of this document. 

3. Modify the script TIPsRunnerFailover.vbs and customize the host and IP Address for each 
node.  For example, for some NodeA in the cluster, the script would be updated such that 
“Physical_Node_Name_Here” would be changed to “NodeA.domain” and 
“Physical_Node_IP_Addr_Here” would be changed to NodeA’s IP Address. 

 

Note: Skipping this step results in communication failures between the TIPs Server and Runner when 
launch TIPs.  The error is most likely to occur when launching a TIP against some  of the cluster’s 
physical nodes. 

 

Remove all the Instances of Local TIP Runners 
Next, the default configuration that was created as part of the installation process is cleaned up.  You 
only need to perform this on the active node since the configuration data is shared via OVIS Clusters 
shared drive. 

1. Stop the TIP Runner  (ovc -stop ovtiprn).  If you have already installed remote OVIS Probes 
pointing to this cluster setup, you will need to stop the TIP Runners on those systems too.  

2. Leave tomcat running (i.e., ovc -status should show ovtomcatA as running)  

3. Bring up the TIPs Config GUI.  

4. Navigate to the TIPs Runner Section.   

5. Remove all the TIP Runner entries (this assumes you don't have running remote systems)  

6. Exit the Config GUI - don't bother with notifying tomcat that the configuration has changes. 

7. Do not restart the TIP Runners.  This should be done after the TIPs Server identity has been 
synchronized with the Cluster’s Virtual Server and the Runners in turn point to that system. 

 

 



Note:  Skipping this clean up operation probably will not result in problems; 
however, it will result in clutter in the TIPs Server information on available TIPs 
Runners.  For example, multiple entries may exist for the same node, where only one 
of the entries is valid and the other is ignored. When in doubt the cleanup can be 
performed at anytime – just make sure all of the TIPs Runners are stopped and then 
remove entries. They should re-register once they are restarted. 

 
TIPs Synchronizations with the Virtual Server  
Here, the TIPs Server and Runner on the Cluster systems will be adjusted to refer to the Virtual Server.  
In the Servers case, its so-called identity will be changed to match that of the Virtual Server.  As for the 
Runner, its communications setup will be changed to go through the Virtual Server as opposed to the 
physical node.  Once again, the steps outlined only need to be performed on the active node (i.e., 
the configuration setting we’re modifying are stored upon the shared drive).  

1. Ensure that both OV Tomcat and the TIPs Runner are stopped (the TIP Runner should still be 
stopped from the above step).  This is performed by either stopping OV Control or the 
individual processes:  
   ovc –stop 
     – or – 
  ovc –stop ovtiprn 
  ovc –stop ovtomcatA 

2. Reset the TIP Runner to refer to the virtual server.   
  ovtiprn –replace <virtual host name> 
  Ex: ovtiprn –replace ovrnttc2.ovrtest.adapps.hp.com 

3. Reset the TIP Server to match up with the virtual server 
  OvTIPsServer.bat -id <virtual host name> 
  OvTIPsServer.bat –host <virtual host name> 
  OvTIPsServer.bat –address <virtual host ip> 
  Ex: OvTipsServer.bat -id ovrnttc2d. ovrtest.adapps.hp.com 
       OvTipsServer.bat –host ovrnttc2d. ovrtest.adapps.hp.com 
       OvTipsServer.bat –address 15.8.156.232 

4. Verify that the TIPs Server is correctly configured by running the following command.  This 
command should show that the host and address are pointing to the virtual server. 
 
  OvTipsServer.bat -retrieve all  
 
  Example Output: 

C:\Documents and Settings\Admin> OvTipsServer.bat -retrieve all 
id: ovrnttc2d.ovrtest.adapps.hp.com 
system: Windows 
version: 5.2.0 
host: ovrnttc2d.ovrtest.adapps.hp.com 
address: 15.8.156.232 
installation: C:\Program Files\HP OpenView 
protocol: http 
application: tips 
port: 6604 
open: true 
secure: false 

 



strict: false 
byte: false 
codeset: false 
iana: 437 
 

Note:  This step must be performed if TIPs is to run in a Cluster environment.  Failure to do so will 
result in TIPs only being available when the physical node that the server is currently associated with 
is running.  In other words it is only going to work on the node where that the initial install was 
performed on.  For both remote systems pointing to the virtual server and the failover nodes, TIPs will 
fail since the advertised server will be down. 
 

TIPs Runner Identity Corrections 
Here you will perform a one time operation to manually synchronize the TIPs Runner id with the 
current active node (i.e., effectively the same steps that the failover script performs).  Like the other 
steps, this one needs to be performed only once on the active node. 

1. The TIPs Runner should still be stopped from the previous steps.  If not, stop it as follows: 
  ovc –stop ovtiprn  

2. Synchronize the id with the active node.  Make sure that Node Name and IP Address match 
up with the entries you used in the failover script on this system. 
  ovtiprn –id <physical_node_name> 
  ovtiprn –host <physical_node_name> 
  ovtiprn –address <physical_node_ipaddr> 
  Ex: ovtiprn -id ovrnttc2a.ovrtest.adapps.hp.com 
        ovtiprn -host ovrnttc2a.ovrtest.adapps.hp.com 
        ovtiprn -address 15.8.155.230 

3. Verify the TIPs Runner configuration by running the following command.  This command 
should show that the host and address are pointing to the currently active node. 
  ovtiprn –retrieve all 
  Example if run on node ovrnttc2a: 

C:\Documents and Settings\Admin>ovtiprn -retrieve all 
id: ovrnttc2a.ovrtest.adapps.hp.com 
system: Windows 
version: 5.2.0 
host: ovrnttc2a.ovrtest.adapps.hp.com 
address: 15.8.155.230 
installation: C:\Program Files\HP OpenView 
protocol: http 
application: tips 
port: 6604 
open: false 
secure: false 
strict: false 
byte: false 
codeset: false 
iana: 437 

4. Restart the tips runner (only after you have reconfigured the tips server):  ovc –start ovtiprn 

Note:  Skipping this step may result in a temporary TIPs failure.  Once the rest of the clustering 
configuration is completed and a failover is performed, the TIPs failover script should correct the 
identity info for the TIPs Runner.  You will then have the additional side effect of cluttering your TIPs 
Server’s list of Runners with a potentially bogus entry. 

 



 

Remote TIPs Runner Configuration 
Special configuration steps are not required for TIPs Runners installed as part of a Remote Probe 
installation.  Simply pointing the probe installation to the virtual server system via the   ‘ovisactivate’ 
step will correctly set the Runner’s configuration. 

 

 

 



Configure Dependencies 
1. In the Cluster Administrator, select the cluster group that contains OVIS and the shared drive. 

(For this example we are using a group called OVIS Group.)  Add the following resources in 
the given order by right clicking on the group and selecting New>Resource. Take note that 
the DTC contains the dependency for the IP and Hostname services to be started. If you are 
not using the DTC service then those dependency will have to be added before the OV 
services are started. 

 

1. Name: OV Shared Trace Service 
Resource Type: Generic Service 
Group: OVIS Group 
Description: Openview Shared Tracing and Logging 
Possible Owners: each node you installed OVIS on 
Dependencies: Shared Drive, DTC 
Service Name: HPOvTrcSvc 
Start Parameters: blank 
Registry Replication: none 
 

2. Name: Tips Runner Failover Script 
Resource Type: Generic Script 
Group: OVIS Group 
Description: Script for enabling the tip runner. 
Possible Owners: each node you installed OVIS on 
Dependencies: Shared Drive, DTC, Shared Trace Service 
Script filepath: C:\Program Files\HP OpenView\lbin\tips\TIPsRunnerFailover.vbs 
 

3. Name: HP OpenView Ctrl Service 
Resource Type: Generic Service 
Group: OVIS Group 
Description: Openview service controller 
Possible Owners: each node you installed OVIS on 
Dependencies: Shared Drive, IIS, Tips Runner Failover Script 
Service Name: OvCtrl 
Start Parameters: blank 
Registry Replication: none 

 

4. Name: OVIS Reporter Service 
Resource Type: Generic Service 
Group: OVIS Group 
Description: Openview reporting service 
Possible Owners: each node you installed OVIS on 
Dependencies: Shared Drive, IIS 
Service Name: Reporter 
Start Parameters: blank 
Registry Replication: none 

 
2.  Name: OVIS HP Internet Service 

Resource Type: Generic Service 
Group: OVIS Group 

 



Description: Internet Services 
Possible Owners: each node you installed OVIS on 
Dependencies: Shared Drive, IIS, OVIS Reporter Service, HP OpenView Ctrl Service 
Service Name: HP Internet Services 
Start Parameters: blank 
Registry Replication: 

SOFTWARE\Hewlett-Packard\HP OpenView 
SOFTWARE\Hewlett-Packard\The Reporter 
SOFTWARE\Hewlett-Packard\Insight 
SOFTWARE\Hewlett-Packard\Internet Services 

 

2. Verify that the Startup Type of all of these services (Reporter, HP Internet Services…….) have 
been changed to Manual so that the cluster can control them 
Start>Programs>Administrative Tools>Services. 

3. Bring the resources online in the same order they were created above. 
 

Other Notes 

Installing Remote Probes 
When performing a remote probe installation, be sure to point the system to the virtual server 
system.  This is required for the continued operations of both the probes and TIPs on the remote 
systems. 
 

Script Probe  
If you are using a script probe you will need to put the script into the:  
<install dir>\newconfig\distrib\<appropriate dir> on all nodes 
After configuring all your script probes on first node you will need to move to the other nodes and 
press Save to have the scripts distributed.  This will have to be done every time a script probe is 
modified or added.  If your script probe is a remote probe then you will only have to press save 
on the first node to get it distributed to the remote probe.  However you still need to put the script 
in the <install dir>\newconfig\distrib\<appropriate dir> on all nodes so that if you press save on 
a different node the remote probe script will still get distributed to the remote probe. 
 

 

Dashboard Drill Down to Probe Locations or Location Details 
If you drill down on the data in the dashboard to the target level depending on the failover time 
selected in the graph you will see graphs for each node. 

 
 

Using a Single License for all probes 
• Using the License Wizard on one of the nodes get a password 

• Use the Enter License Directly Option in the Config manager to put the license onto the other 
nodes: 

o File | Configure | License 

o File | OVIS License | Enter License Directly  

 



o Paste in the licenses you received via email 
 

Secure Communications for TIPS 
Follow the online guide for setting up secure core communications with the following 
exceptions: 
For the server that is specified in the ovconfchg command - refer to the OVIS Group cluster 
system - not the physical node. 
  
Just do the certificate granting on the active cluster node - and it is enough to only set the secure 
mode to true for the TIPs Server and local runner on that system only. 

 

Deploying the OVO for Windows Agent 
Follow the directions for deploying the OVO/W agent.   

• Install the OVIS Integration software on the OVO/W Server and use the virtual name for 
the OVIS Server (example: ovrnttc2).   

• Deploy the agent to both nodes (example: ovrnttc2a and ovrnttc2b).   

• Deploy the OVIS Alarms Policy to both nodes (example: ovrnttc2a and ovrnttc2b).   

• Deploy the OvisUpdateServices to the OVOW Server. 

• Configure the OVIS Server (example: File | Configure | Alarm Destinations,  OVO 
Integration – Default, Options – Enable Continuous Alarming) 

NOTE: You might see an alarm from the recently failed over node until there is a state change or 
the alarm is acknowledged.    
 

 

 



Uninstalling OVIS 
1. If the replitekey.mxk and repkey.mxk files exist on the data drive, make a copy of 

them. 

2. Take all the Resources that were added during the Configuring Dependencies step of the 
installation/configuration offline in the Cluster Administrator. 

3. Once the Resources are offline, delete them in the Cluster Administrator. 

4. Uninstall OVIS from the active node that has ownership of the OVIS Shared Disk group. 

5. Put the copy of replitekey.mxk and repkey.mxk back in the Data directory of the 
shared drive.  If you do not have copies of these files you can run repair.vbs, from the 
Support directory of the OVIS installation CD. 

6. Move the OVIS Shared Disk group to the other OVIS node in the Cluster Administrator. 

7. Uninstall OVIS from the active node that now has ownership of the OVIS Shared Disk group. 
 

 



Troubleshooting 

OVIS Installation stops before finishing 
If you get a message that the installation has been interrupted before completion, make sure the 
ComponentMatrix.cfg and DependencyMatrix.cfg files do not exist in the conf 
subdirectory of the data drive. 
e.g, G:\Program Files\HP OpenView\Data\conf\ComponentMatrix.cfg 
e.g, G:\Program Files\HP OpenView\Data\conf\DependencyMatrix.cfg 

 

OVIS Installation Hangs 
• Make sure SQL Server is online. 

• Check the ovis_install.log file in the HPOVInstall subdirectory of the Data drive. 

 

OVIS Won’t Collect Data 
• Make sure the correct fully qualified name for the virtual server is configured in the Web 

Server Properties and in the config.dat file in the probes directory.  If the server name in 
config.dat is incorrect, restart the HP Internet Services Service after saving the change.    

net stop “HP Internet Services”; 

net start “HP Internet Services” 

• Check the status.iops file in the Data directory for messages that might indicate the 
problem. 

OVIS Pressing Save in Config Manger Causes HTTP Status Error 400 
• Check that the default Web Site has “(All Unassigned)” for the “IP Address”. 

OVIS Uninstall Fails 
• Make sure the replitekey.mxk and repkey.mxk files exist in the Data directory of the 

shared drive.  If you do not have copies of these files you can run repair.vbs, from the 
Support directory of the OVIS installation CD. 

• Make sure the OVIS resources have been removed from the Cluster Administrator.  If you 
missed this step, you may need to reinstall OVIS before the uninstall will complete 
successfully. 

Dashboard not Working 
• Make sure the virtual directories have read permission. 

• Make sure OV Control (Tomcat is running). On the command line issue the command; ovc –
status, if it’s not running issue the command ovc -start 

Data Consolidation Not Working 
• Make sure the reporter service is running.  

Config Manager Errors for a passive node 
• You may get database connection errors in the OVIS Configuration Manger if the probe data 

received tabs on a passive node. This is expected since the database and OVIS are running 
on the other nodes. It is recommend that users always use OVIS on the active node.   

 



 
Tip for Local System Timing Out 

• Make sure the tip you are running is for the currently active node.  You may have to use the 
drop down location list to get the currently active node.  See CR: QXCR1000285624 

 

Tips on Second Node is Not Operational after the Failover  
The TIPs request cannot execute.  
Probable Cause: An IP address cannot be found for requested probe location '<Node1>' for the TIPs 
request. Consult the TIPs Server log file.  
By this time, the control already moved to next node, hence the above error is an expected one. If the 
TIPs Script is unable to start or the script cannot be modified or deleted then remove resource and 
recreate it based upon the above instructions. 

 



Appendix 

TIPsRunnerFailover Script 
 
This is a vbs script so save it to the name TIPsRunnerFailover.vbs 
 
Call Main 
Sub Main 
    On Error Resume Next 
    Dim svHost, svIPAddress, svID, svCmdDir, svCommand, svParameters 
    Dim bReturn 
    gbExecMain = True 
 
    ' 
    ' Customize host and IP Address for your system 
    ' 
    svHost = "OVRNTTC2B.ovrtest.adapps.hp.com" 
    svIPAddress = "15.8.155.231" 
 
    ' 
    ' Customize installation directory for your system 
    ' 
    svCmdDir = "C:\Program Files\HP OpenView\bin\"  
    svID = svHost & " " & svIPAddress 
    svCommand = "ovtiprn.exe" 
 
    ' 
    ' Set the TIPs Runner ID 
    ' 
    svParameters = "-id " & Chr(34) & svID & Chr(34) 
    bReturn = runCmd(svCmdDir , svCommand, svParameters, FALSE) 
 
    ' 
    ' Set the TIPs Runner hostname 
    ' 
    svParameters = "-host " & Chr(34) & svHost & Chr(34) 
    bReturn = runCmd(svCmdDir , svCommand, svParameters, FALSE) 
 
    ' 
    ' Set the TIPS Runner IPAddress 
    ' 
    svParameters = "-address " & Chr(34) & svIPAddress & Chr(34) 
    bReturn = runCmd(svCmdDir , svCommand, svParameters, FALSE) 
 
End Sub 
 
'********************** 
' Generically Run a command 
' and report any errors. If the command needs 
' any parameters, the caller must package up the parameter 
' script with embedded double quotes like this: 

 



'     "-option " & Chr(34) & value & Chr(34 
'************************* 
Function runCmd(svRootDir, svCmd, svParameters, bShowGUI) 
  On Error Resume Next 
  err.Clear 
  Dim bErrReturn, iShowGUIDisplay, svCommand, svPreviousDir 
 
  runCmd = False 
  bErrReturn = 0 
 
  svCommand = svRootDir & svCmd 
  set fileSystemObj = CreateObject("Scripting.FileSystemObject") 
  If(fileSystemObj.FileExists(svCommand))Then 
    ' Determine if we need interaction with the user 
    iShowGUIDisplay = 0 
    If (bShowGUI) Then 
      iShowGUIDisplay = 1 
    End If 
 
    ' Build the command to be executed 
    ' Append any parameters 
    If (svParameters = "") then 
      svCommand = Chr(34) & svCommand & Chr(34) 
    Else 
      svCommand = Chr(34) & svCommand & Chr(34) & " " & svParameters 
    End If 
 
    ' Execute in the root directory as some commands 
    ' assume they are executed where they reside 
        
    svPreviousDir = WSH_Shell.CurrentDirectory 
    set WSH_Shell = CreateObject("WScript.Shell") 
    WSH_Shell.CurrentDirectory = svRootDir 
    err.Clear 
    bErrReturn=WSH_Shell.Run(svCommand, iShowGUIDisplay, True) 
    If ((bErrReturn<>0) Or (err.Number<>0)) Then 
      WSH_Shell.CurrentDirectory = svPreviousDir 
      Exit Function 
    End If 
    WSH_Shell.CurrentDirectory = svPreviousDir 
  Else 
    Exit Function 
  End If 
 
  runCmd = True 
end Function 
 
'************************* 
' Added from clusweb.vbs  
' scirpt to get cluster to  
' add this generic script 
'************************* 
 

 



Function LooksAlive( ) 
    LooksAlive = True 
End Function 
 
'************************* 
' Added from clusweb.vbs  
' scirpt to get cluster to  
' add this generic script 
'************************* 
Function IsAlive( ) 
 IsAlive= True 
End Function  
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